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1iPlus Ver. 2.0-VI (Answer Key)

	 �Categories of Computers and Computer 
Languages

Let’s Catch Up (Page 12)

	 1.	 Hybrid	 2.	 Tablet	 3.	 Supercomputers

Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 b 	 3.	 d	 4.	 c	 5.	 a
B.	 1.	 microcomputer	 2.	 laptop	 3.	 instructions	 4.	 programming 
	 5.	 assembler
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T

Section B (Subjective)

A.	 1.	 A microcomputer is a type of computer that has one microprocessor as its processing unit. 
It is a small and less expensive digital computer. This type of computer is made to be used 
by a single user at a time. A Microcomputer is also called a Personal Computer (PC). 

	 2.	 A handheld computer is a type of computer that can easily be stored in our pockets and 
used by holding it in our hands. Most handheld computers have a touchscreen on which 
we input data by using our fingers. Some commonly used examples of handheld computers 
are smartphones, smartwatches, PDAs, and gaming consoles.

	 3.	 A compiler is a program that converts the entire source program into machine language 
before executing it. It converts the entire program into machine language at once. It displays 
the errors for the whole program together.

	 4.	 Computers need a language to communicate with its user, take instructions, and perform 
operations. The language that is required by a computer is called computer language. This 
is also known as a programming language.

1.



iPlus Ver. 2.0-VI (Answer Key)2

IMPRINT 1

B.	 1.	 An embedded computer is a special type of microprocessor-based system that is developed 
for performing a specific task. It is different from a general-purpose computer like a PC. 
Today, embedded computers are used in various applications. Two embedded computers 
are digital camera and microwave.

	 2.	 Digital computer refers to a computer that uses digits (binary numbers 0’s and 1’s) to 
generate, process, and display data. The results produced by digital computers are more 
accurate than those of analog computers. Two examples of digital computers are laptops 
and smartphones.

	 3.	 A compiler is a program that converts the entire source program into machine language before 
executing it. It converts the entire program into machine language at once. It displays the errors 
for the whole program together whereas an interpreter reads one line of instruction at a time 
and translates it into machine language. Any error in the instruction is reported immediately 
and the programmer can correct it accordingly. 

	 4.	 The disadvantages of High-level languages are:
		  a. � A high-level language has to be translated into machine language by a translator, which 

wastes a lot of the computer’s time.
		  b. � The object code generated by a translator might be inefficient as compared to an equivalent 

assembly language program.
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 File Management—Organisation of Data

Let’s Catch Up (Page 24)

Step 3:	 Click on the Cut command.
Step 5:	 Click on the Paste command.
Step 1:	 Click on File Explorer.
Step 4:	 Click on the drive where you want to move the file or folder.
Step 2:	 Select the file.

Exercise
Section A (Objective)

A.	 1.	 b 	 2.	 c 	 3.	 c	 4.	 a	 5.	 a
B.	 1.	 file format	 2.	 .pptx	 3.	 partitions	 4.	 asterisk	 5.	 audio
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T
D.	 1.	 d	 2.	 c	 3.	 e	 4.	 a	 5.	 b

Section B (Subjective)

A.	 1.	 Data is arranged in a computer by type, by size, by name and by date of creation and 
modification.

	 2.	 Sorting is used to arrange the files in a computer.
	 3.	 Asterisk(*) and question mark(?) are the types of wildcard characters.
	 4.	 Show windows side by side option is used to open multiple applications in windows.
B.	 1.	 While searching, Asterisk represents a string of characters whereas Question mark represents 

a single character while searching.
	 2.	 File Explorer is the default file management application in Windows operating systems. File 

Explorer helps us organise and manage files and folders. 
	 3.	 The steps to sort the files as per Size are as follows:
		  Step 1:	  Click on the Sort by command.
		  Step 2:	  Select the Size option.
		  The files and folders will be arranged as per the size of the files.
	 4.	 We use wildcard for searching when we don’t know the location and complete name of the 

file.

2.
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C.	 Competency-based/Application-based questions:	
	 1.	 Sahil should use cut command instead of copy command.
	 2.	 By checking the file extension of both the files, the presentation will have .pptx extension 

and Word file will have .docx extension.
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	Word Processor—Tabular Representation

Let’s Catch Up (Page 35)

Step 1:	 Insert	
Step 2:	 Table	
Step 3:	 Insert Table	
Step 5:.	OK

Exercise
Section A (Objective)

A.	 1.	 b 	 2.	 b 	 3.	 c	 4.	 a
B.	 1.	 decreasing, increasing	 2.	 Merging	 3.	 Layout	 4.	 Table	 5.	 Delete Rows
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 T	 5.	 T

3.



IMPRINT 1

5iPlus Ver. 2.0-VI (Answer Key)

Section B (Subjective)

A.	 1.	 The intersection of a row and a column in a table is called a cell.
	 2.	 Resizing a table means increasing and decreasing the size of the table.  
	 3.	 Table Styles is a feature with which a user can format the entire table quickly.
B.	 1.	 The steps to add a column in a table are:
		  Step 1: Select the column where you want to add an additional column.
		  Step 2: Click on the Layout tab.
		  Step 3: Click on the desired option.
	 2.	 To insert a table, follow these steps:
		  Step 1: Click on the Insert tab.
		  Step 2: Click on the Table drop-down arrow.
		  Step 3: �Click on the top left corner of the grid and drag the mouse to highlight the number 

of columns and rows you want in the table.
		  The table will be inserted into the document.
	 3.	 The steps involved in splitting a cell are:
		  Step 1: Select the cells that you want to unmerge. 
		  Step 2: Click on Layout tab. 
		  Step 3: Click on Split Cells command.
		  Step 4:  �Enter the desired number for columns into the Number of Columns box and number 

of rows into the Number of Rows box. 
		  Step 5: Click on OK button. 
	 4.	 Division of cells into two or more sub-cells is known as splitting of cells whereas combining 

two or more adjacent cells in the same row or column is known as merging of cells.

Crack The Code
	 1.	 Delete 		  2.  Insert above 	 3.	 Insert below	 4.	 Insert Left

 Word Processor—Mail Merge

Let’s Catch Up (Page 44)

Mail Merge is used to send the same letter with different names and addresses so that the same 
letter is addressed to different  recipients. 

4.
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Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 d 	 3.	 c	
	 4.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question.	Which of these commands allows you to add a greeting line to the letter?
			   a. Insert Merge Field 		  b. Address Block
			   c. Greeting Line 				    d. Start Mail Merge
		  Ans. c
	 5.	 a	 6.	 c
B.	 1.	 Mail Merge			  2.	 Main Document		  3.	 Mailings	
	 4.	 Write & Insert Fields
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 T	 5.	 F

Section B (Subjective)

A.	 1.	 Mail Merge is a feature of Word processor like Word, in which names and addresses of 
different recipients are merged in one file and each pair of name and address is merged 
with a copy of particular letter by itself, so that the same letter is addressed to different 
recipients. 

	 2.	 Data source is a separate file that contains all information about recipients of the letter.
	 3.	 The name of the command used to add addresses list is Type New List.
	 4.	 Two advantages of Mail Merge are:
		  a. It saves time and effort.
		  b. It allows us to make changes in several letters very quickly.
B.	 1.	 There are three main components of Mail Merge in MS Word which are as follows:
		  a. �Main Document: It is a document that contains the text of the letter which we want to 

send to our friends.
		  b. Data Source: It is a separate file that contains all information about recipients of the letter
		  c. �Merged Document: It is the final document created by merging the Main Document and 

Data Source. It contains a list of letters with text and detail of a person.
	 2.	 The steps to create a Data Source in Mail Merge are:
		  Step 1: Click on Mailings tab. 
		  Step 2: Click on Select Recipients. 
		  Step 3: Select Type a New List. 
		  Step 4: Add the details of the recipients. 
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		  Step 5: Click on OK button. 
		  Step 6: In File name box, type the name of the list to save.
		  Step 7: Click on the Save button. 
	 3.	 Merged Document is the final document created by merging the Main Document and Data 

Source. It contains a list of letters with text and detail of a person.
		  The steps to print a merged document are:
		  Step 1: �Click on the Preview Results command from the Preview Results group under the 

Mailings tab.
		  Step 2: �Click on the arrow buttons in the Preview Results group under the Mailings tab to 

see a preview of each letter.
		  Step 3: Click on the Finish & Merge command from the Finish group under the Mailings tab. 
		  Step 4: Select the Print Documents option. 
			  The Merge to Printer dialog box will appear. 
		  Step 5: Select the All option and click on the OK button. 

C.	 Competency-based/Application-based questions:	
	 1.	 (a) Both Assertion (A) and Reason (R) are true, and Reason (R) is a correct explanation of 

Assertion (A).
	 2.	 Rohit can send the invitation by Mail merge feature of Word.
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 Presentation—Visual Effects

Let’s Catch Up (Page 59)

	 1.	 a
	 2.	 a

Exercise
Section A (Objective)

A.	 1.	 c 	 2.	 d 	 3.	 c	 4.	 a	 5.	 c
B.	 1.	 Video, Insert 	 2.	 slide	 3.	 Object	
	 4.	 Animation Pane	 5.	 PowerPoint
C.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 T

Section B (Subjective)

A.	 1.	 Slide Sorter View, the user can view more than one slide in a small size on the screen.
	 2.	 Animation facilitates the display of presentation of contents in a special sequence of typical 

effects leading to interesting and lively presentation. It includes multiple types of media 
control like graphics, video, sound, music, movies, etc.  

	 3.	 The Reading view is used to see how a presentation will run as a slide show. This view runs 
the presentation in a separate window. 

		  In the Notes Page view, the slides are displayed in a reduced form on top of the page. 
Towards the bottom side, there is a text box in which notes for the slide can be added. 

B.	 1.	 The steps to insert an online video file into a presentation are:
		  Step 1: Click on the Insert tab.
		  Step 2: Click on Video command. 
			  Step 3: Click on Online Video option. 
	 2.	 Action button is used to move from one slide to another and play media files. There are 12 

different types of action buttons available in PowerPoint. 
	 3.	 The steps to import data from other applications into PowerPoint are:
		  Step 1: Click on the Insert tab. 
		  Step 2: Click on the Object command.
		  Step 3: Select the Create from file option if you want to import an existing file. 
		  Step 4: Click on the Browse button. 

5.
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		  Step 5: Navigate to the location where you have saved the file and select the file. 
		  Step 6: Click on the OK button. 
		  Step 7: �Select the Display as icon check box if you want to display the imported file as an 

icon. 
		  Step 8:	 Click on the OK button.
C.	 Competency-based/Application-based questions:	
	 1.	 Action button
	 2.	 Animation
	 3.	 (a) Both Assertion (A) and Reason (R) are true, and Reason (R) is a correct explanation of 

Assertion (A).

Crack The Code
(This question was printed incorrectly in the book, please correct it in your textbook)
Question. Solve the crossword using the given clues.

1

6

3

4

2

5

Across:
	 1.	 Tab that allows you to add an action button
	 2.	 The movement of text and other objects on a slide during a slide show
	 3.	 View that allows to see a presentation not in full screen but in a window with simple controls 

that make the presentation easy to review
	 4.	 Command we can use to add a video file into a presentation
Down:
	 5.	 These determine how the presentation moves from one slide to the other
	 6.	 The key pressed along with the F5 key to start the slide show from the current slide
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	Ans. 

N S E R

H

F
T

I1

S
6

T
5

2 A N I M A T I O N
R

EDI4 V O

I N GDAE3 R

N
S

T

O
N

Worksheet 1  (Based on chapters 1 to 5)

A.	 1.	 Desktop, Laptop
	 2.	 PDP-11, PDP-8
	 3.	 ATM,  Microwave
	 4.	 Smartphone, Smartwatch
B.	 1.	 A wildcard is a special character which is used to represent one or more characters.
	 2.	 Splitting refers to dividing one cell into two or more cells.
	 3.	 The Mail Merge feature in MS Word is used to create personalised letters to be sent to many 

people.
	 4.	 Notes pane is the area where a speaker can write notes for himself.
C.		  (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. Write the name of the tab in which the following options of Word are present:
					     Option	      Tab
				    1.	 Table		 _______________

				    2.	 Table Column Width		 _______________

				    3.	 Autofit		 _______________

				    4.	 Merge Cells		 _______________

				    5.	 Table Styles		 _______________

		  Ans. 1. Insert  2. Layout  3. Layout  4. Layout  5. Design
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D.	 1.	 Hybrid	 2.	 Assembler	 3.	 Right-click	 4.	 Data Source		  5.  Animation
	 6.	 Slide Sorter View

(Based on chapters 1 to 5)
Test Sheet 1

Section A 

A.	 1.	 a	 2.	 a	 3.	 c	 4.	 b	 5.	 a
	 6.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. Which of these commands allows you to add a greeting line to the letter?
				    a.	 Insert Merge Field 	 b.	Address Block
				    c.	 Greeting Line 			   d.	 Start Mail Merge
		  Ans. c
	 7.	 c	 8.	 c
B.	 1.	 microcomputer	 2.	 partitions	 3.	 audio	 4.	 Merging
	 5.	 Mailings			   6.	 Animation Pane
C.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 T	 6.	 T

Section B 

A.	 1.	 A microcomputer is a type of computer that has one microprocessor as its processing unit. 
It is a small and less expensive digital computer. This type of computer is made to be used 
by a single user at a time. A Microcomputer is also called a Personal Computer (PC).

	 2.	 File Explorer is the default file management application in Windows operating systems. File 
Explorer helps us organise and manage files and folders. 

	 3.	 Table Styles is a feature with which a user can format the entire table quickly.
	 4.	 The name of the command used to add addresses list is Type New List.
	 5.	 Slide Sorter View, the user can view more than one slide in a small size on the screen.
	 6.	 Animation facilitates the display of presentation of contents in a special sequence of typical 

effects leading to interesting and lively presentation. It includes multiple types of media 
control like graphics, video, sound, music, movies, etc.

B.	 1.	 Digital computer refers to a computer that uses digits (binary numbers 0’s and 1’s) to 
generate, process, and display data. The results produced by digital computers are more 
accurate than those of analog computers. Two examples of digital computers are laptops 
and smartphones.

	 2.	 We can search files or folders through File Explorer if we exactly know the name of the file 
or the extension of the file.
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	 3.	 To insert a table, follow these steps:
		  Step 1: Click on the Insert tab.
			  Step 2: Click on the Table drop-down arrow.
		  Step 3: �Click on the top left corner of the grid and drag the mouse to highlight the number 

of columns and rows you want in the table.
		  The table will be inserted into the document.
	 4.	 The steps to create a Data Source in Mail Merge are:
		  Step 1: Click on Mailings tab. 
		  Step 2: Click on Select Recipients. 
		  Step 3: Select Type a New List. 
		  Step 4: Add the details of the recipients. 
		  Step 5: Click on OK button. 
		  Step 6: In File name box, type the name of the list to save.
		  Step 7: Click on the Save button.
	 5.	 Action button is used to move from one slide to another and play media files. There are 12 

different types of action buttons available in PowerPoint. 
	 6.	 The steps to import data from other applications into PowerPoint are:
		  Step 1: Click on the Insert tab. 
		  Step 2: Click on the Object command.
		  Step 3: Select the Create from file option if you want to import an existing file. 
		  Step 4: Click on the Browse button. 
		  Step 5: Navigate to the location where you have saved the file and select the file. 
		  Step 6: Click on the OK button. 
		  Step 7: �Select the Display as icon check box if you want to display the imported file as an 

icon. 
		  Step 8: Click on the OK button.

 Scratch Programming—Game Creation

Let’s Catch Up (Page 73)

	 1.	 Sprite
	 2.	 Coding Area
	 3.	 Script

6.
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Exercise
Section A (Objective)

A.	 1.	 c 2. a 3. c 4. b 5. b
B.	 1.	 pen	 2. regular 3. stamp 4. sound 5. operators
C.	 1.	 F	 2. F 3. T 4. T 5. T
D.	 1.	 Control block 2. Looks block

3. Motion block 4. Events block

Section B (Subjective)

A.	 1.	 Pen blocks in Scratch allow a Sprite to draw shapes and plot coloured pixels on the screen.
2. The components of Scratch window are Sprite, Stage, Blocks palette and Scripts area.
3. Block palette contains various predefined blocks that are used to perform specific tasks.

These blocks are used to create scripts in Scratch.
4. Repeat block is used to draw a pentagon.
5. Two conditional control blocks are: Forever and Repeat Until.

B.	 1.	 The four methods to choose a sprite are:
(i)   Paint a new sprite
(ii)  Choose a sprite from the library
(iii)  Upload a sprite from file
(iv)  Surprise

2. Blocks are puzzle piece shapes that are used to give instructions to the computer.
Two blocks are: Control and Events.

C.	 Competency-based/Application-based questions:	
1. Vishal can follow the given steps:

		 Step 1: Hover the mouse over Choose a Sprite button.
		 Step 2: Select Paint option.
		 Step 3: Use the tools to draw the Sprite.

2. (d) Assertion (A) is false, and Reason (R) is true.
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 HTML—An Introduction

Let’s Catch Up (Page 89)

	 a.	 The tags that have both opening and closing tags are called Container Tags. 
	 b.	 Empty tags contain only opening tag. They do not have a closing tag. 
	 c.	 Nesting of tags means that you can start a new tag before closing the previous tag. 
	 d.	 An attribute is a property that provides some additional information about a tag. 

Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 b 	 3.	 a	
	 4.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. Which of the following has opening and closing tags?
			   a. Empty tag 			   b. Container tag
			   c. Both a & b 			   d. None of these
		  Ans. b

7.
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B.	 1.	 Markup	 2.	 Head	 3.	 Block Level	 4.	 Empty	 5.	 Nesting
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 F

Section B (Subjective)

A.	 1.	 HTML is a markup language that describes the structure of the web page.
	 2.	 The tags that have both opening and closing tags are called container tags.
	 3.	 The <HEAD> tag defines header area of your web page.
B.	 1.	 Rules for writing HTML codes are:
		   Values given to the attributes should be enclosed within the double quotes.
		   Tag name should not contain spaces.
		   There should be no spaces between < and > in a tag.
		   Tags must be nested correctly.
	 2.	 WYSIWYG Editor: 	WYSIWYG stands for What You See Is What You Get. This type of editor 

allows the developer to see what the end result will look like when the document is created. 
These editors provide various tools and graphical interfaces where the web pages are 
designed. Examples of WYSIWYG editors are Adobe Dreamweaver, Amaya and Google Web 
Designer. 

		  Text Editor: We can create HTML documents using normal text editors like Notepad or 
Wordpad. The user should have a proper knowledge of the HTML commands to develop a 
web page.

	 3.	 The Line Break tag is written as <BR>. This tag is used when you want to start a new line, 
but do not want to start a new paragraph. This means that you want your text to come in 
the next line without leaving a blank line in between. 

		  The Horizontal ruler tag is written as <HR>. This tag is used when you want to divide your 
web page into different sections. It is also used when you want to draw a line between two 
paragraphs. 

C.	 Competency-based/Application-based questions:	
	 1.	 Ajit can use the heading tags to add heading.
	 2.	 Anjali can use <TITLE> tag to add the title.
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 Online Surfing and Cybersecurity

Let’s Catch Up (Page 107)

	 a.	 T		  b.	 F	 c.	 T

Exercise
Section A (Objective)

A.	 1.	 c 	 2.	 a 	 3.	 c	 4.	 d	 5.	 a
B.	 1.	 data diddling	 2.	 e-greeting			   3.	 newsgroup
	 4.	 cybersecurity	
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T	 5.	 T

Section B (Subjective)

A.	 1.	 Carding refers to the process of stealing credit card numbers online, to be resold or used to 
charge merchandise against the victim’s account. 

	 2.	 Etiquettes are the rules that are expected to be followed while meeting or communicating with 
others. This set of rules is known as Netiquettes. It basically stands for Network Etiquettes.

8.
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	 3.	 Use of social networking services is not advisable for students because these services are 
generally considered as a source of distraction from education for students.

	 4.	 Hacking is the practice of modifying computer hardware and software to accomplish a goal 
outside of the creator’s original purpose.

	 5.	 A cloud storage is a service where the users are able to store and manage data on remote 
server in place of their local computer.

B.	 1.	 Four benefits of e-banking are:
		   Less transaction costs 
		   Less chances of human error
		   Reduced paperwork 
		   Customer loyalty and satisfaction 
	 2.	 Different types of Communication techniques are:
		  (i) �	� E-mail: E-mail stands for electronic mail. We can send messages and files from our 

computer to your friend’s computer and vice-versa using e-mail service. It is fast and 
generally delivered within few seconds (depending on the network speed) after sending.

		  (ii) �	� Video Conferencing: We use telephones and mobiles to talk to your friends and 
relatives. With the advancement in technology, we can now see the person with whom 
we are talking. The technique of watching the person while talking to him is called video 
conferencing. In video conferencing, there can be two or more persons at different 
locations simultaneously talking to each other by both audio as well as video.

		  (iii) �	�Voice-over-Internet Protocol (VoIP): Voice-over-Internet Protocol (VoIP) is a technology 
which gives calling facility over the Internet. It is basically used for voice communications.

	 3.	 The differences between hacking and cracking are:
		  Hacking
		   Practice of modifying computer hardware and software.
		   People engaged are called as hackers.
	 	 Cracking
		   Process of stealing personal information.
		   People engaged are called as crackers.
	 4.	 There are various types of cyber threats. Some of them are as follows:
		  (i)	 Data Diddling: Refers to the process of changing the data going into or out of a computer.
		  (ii) �	�Phreaking: This crime is committed against telephone companies by using computers 

with the goal of making free distance calls or tapping phone lines.
		  (iii) �Cloning: This refers to a fraud in which scanners are used to steal the electronic serial 

numbers of cellular phones, which may used for billing purposes and making broadcast 
calls.
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		  (iv)	�Carding: This refers to the process of stealing credit card numbers online, to be resold 
or used to charge merchandise against victim’s account.

		  (v)	� Hacking: Computer hacking is the practice of modifying computer hardware and software 
to accomplish a goal outside of the creator’s original purpose.

		  (vi)	�Cracking: The process or stealing personal information, changing financial data, breaking 
security systems to gain unauthorized access of computer systems is called cracking.

C.	 Competency-based/Application-based questions:	
	 1.	 E- banking			   2.	 No, this is a wrong way

Crack The Code
(This question was printed incorrectly in the book, please correct it in your textbook)
Question. Find the names of any eight Internet services in this grid.
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 E-mail—An Introduction

Let’s Catch Up (Page 113)

		  Two features of an e-mail are:
		  a. Ability to attach the files along with the message 
		  b. Ability to store information such as messages and contact lists 

9.
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Exercise
Section A (Objective)

A.	 1.	 c 	 2.	 a 	 3.	 d	 4.	 b	 5.	 c	 6.	 c
B.	 1.	 Bcc	 2.	 To	 3.	 Cc	 4.	 Attachment	 5.	 Sent
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T	 6.	 F

Section B (Subjective)

A.	 1.	 Internet is a computer network that connects hosts and end systems throughout the world.
	 2.	 Acronyms work like shorthand for Internet users as it saves typing time.
	 3.	 Spam is the folder where all unwanted incoming e-mails are stored so that they stay out of 

the inbox folder.
	 4.	 An electronic mail or e-mail can be defined as the process of exchanging messages 

electronically through a communications network by clicking on it.
B.	 1.	 To login to an e-mail account, follow the given steps:
		  Step 1: Type www.gmail.com in the address bar and press Enter key.
		  Step 2: Enter username of the email address that you have created.
		  Step 3: Click on the Next button.
		  Step 4: Enter the password you had created for your email account.
		  Step 5: Click on the Next button.
	 2.	 E-mail has various advantages, some of them are:
		   An e-mail can be sent anytime and from anywhere in the world.
		   An e-mail can be sent to many people at a time.
		   An e-mail can be easily forwarded to anyone without typing it again.
		   Sending an e-mail is fast in comparison to traditional mails.
	 3.	 Inbox is the folder where all e-mails that you have received from others are stored whereas 

Outbox is the folder where all outgoing e-mails are temporarily stored. Once all the e-mails 
have been sent, the Outbox folder gets empty. 

C.	 Competency-based/Application-based questions:	
	 1.	 He can send music file by using attachment option.
	 2.	 Ajay’s e-mail id in ‘To’ field and others e-mail address in ‘Bcc’ section.
	 3.	 He should log out of his e-mail account.

Crack The Code
	 a.	 Cc	 b. 	To	 c.	 Subject	 d.	 Bcc
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  More on Internet

Let’s Catch Up (Page 131)

	 a.	 Debit or Credit Card 
	 b.	 Net Banking 
	 c.	 E-Wallet 

Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 a 	 3.	 b	 4.	 d	 5.	 a
B.	 1.	 blog	 2.	 blogger	 3.	 online	 4.	 cash on delivery		 5.	 drive
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	
	 5.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. A podcast is like an online on-demand radio show.
		  Ans. T

Section B (Subjective)
A.	 1.	 Google Docs option is used to create word file on Google Drive.
	 2.	 The process of purchasing products online is called online shopping.
	 3.	 OTP stands for one time password.
	 4.	 Two e-commerce websites are Amazon and Flipkart.
B.	 1.	 Blogging is the act of writing and maintaining a blog, which includes photography and other 

media that are self-published online. Readers of blog can also comment. When more readers 
comment, the blog becomes more popular. Podcasts and Photologs are types of blogs.

	 2.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. What do you mean by podcasting? Give any two examples of podcast software.
		  Ans. �The process of making digital recordings (audio or video) that are available for 

downloading is called podcasting. iPodder and iTunes are examples of podcast software.
	 3.	 The modes of payment of an e-commerce website are:
		  a. �Debit or Credit Card: E-commerce websites allow us to make payment by using our credit 

or debit card. We make payment by using the debit card which will be debited from the 
bank account. 

		  b. �Net Banking: We can directly use the bank account to make payments online. Every bank 
provides a unique Customer ID or Net Banking ID and a PIN to each customer of the bank. 

10.
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		  c. �Cash on Delivery (COD): Most e-commerce websites allow us to make the payment by 
cash while receiving the product at your residence. 

C.	 Competency-based/Application-based questions:	
	 1.	 She can use Blogger, Tumblr or WordPress websites to write the article.
	 2.	 She can upload the files to Google Drive and access them anywhere she wants.
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Worksheet 2  (Based on chapters 6 to 10)

A.	 1.	 Backdrop is a background of the stage.
	 2.	 Sprite is an object that we see on the scratch stage.
	 3.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. Coding Area
		  Ans. �Coding Area is the area where we pick and drop the blocks from the Blocks Palette to 

create a script/program.
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	 4.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. Go Button
		  Ans. Go Button is used to run a Scratch program.
B.	 1.	 Adobe Dreamweaver 		  Amaya
	 2.	 <BR> 				    <HR>
	 3.	 Communication 		  E-Banking
	 4.	 Net B	anking 			  E-Wallet
C.	 1.	 Pen
	 2.	 Stamp
	 3.	 Web browser
	 4.	 element
	 5.	 Attribute
	 6.	 Social networking
	 7.	 Cloud storage
	 8.	 Spam
D.	 1.	 Hyper Text Markup Language
	 2.	 Standard Generalized Markup Language
	 3.	 Automated Teller Machine
	 4.	 One Time Password
	 5.	 Carbon Copy
	 6.	 Blind carbon copy
	 7.	 Voice-over-Internet Protocol 
	 8.	 COmmon Business Oriented Language

(Based on chapters 6 to 10)
Test Sheet 2

Section A 

A.	 1.	 a	 2.	 c	 3.	 b	 4.	 b	 5.	 a
	 6.	 b	 7.	 c	 8.	 c	
B.	 1.	 blog	 2.	 sound	 3.	 Head	 4.	 data diddling 
	 5.	 Sent	 6.	 Drive
C.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 F	 6.	 T
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Section B 

A.	 1.	 Google Docs option is used to create word file on Google Drive.
	 2.	 Carding refers to the process of stealing credit card numbers online, to be resold or used to 

charge merchandise against the victim’s account.
	 3.	 Repeat block is used to draw a pentagon.
	 4.	 HTML is a markup language that describes the structure of the web page.
	 5.	 Hacking is the practice of modifying computer hardware and software to accomplish a goal 

outside of the creator’s original purpose.
	 6.	 Acronyms work like shorthand for Internet users as it saves typing time.
B.	 1.	 Blogging is the act of writing and maintaining a blog, which includes photography and other 

media that are self-published online. Readers of blog can also comment. When more readers 
comment, the blog becomes more popular. Podcasts and Photologs are types of blogs.

	 2.	 Blocks are puzzle piece shapes that are used to give instructions to the computer.
		  Two blocks are: Control and Events.
	 3.	 WYSIWYG Editor 
		  WYSIWYG stands for What You See Is What You Get. This type of editor allows the developer 

to see what the end result will look like when the document is created. These editors provide 
various tools and graphical interfaces where the web pages are designed. Examples of 
WYSIWYG editors are Adobe Dreamweaver, Amaya and Google Web Designer. 

		  Text Editor 
		  We can create HTML documents using normal text editors like Notepad or Wordpad. The 

user should have a proper knowledge of the HTML commands to develop a web page.
	 4.	 The differences between hacking and cracking are:
		  Hacking
		   Practice of modifying computer hardware and software.
		   People engaged are called as hackers.
		  Cracking
		   Process of stealing personal information.
		   People engaged are called as crackers.
	 5.	 Inbox is the folder where all e-mails that you have received from others are stored whereas 

Outbox is the folder where all outgoing e-mails are temporarily stored. Once all the e-mails 
have been sent, the Outbox folder gets empty.

	 6.	 (This question was printed incorrectly in the book, please correct it in your textbook)
		  Question. What do you mean by podcasting? Give any two examples of podcast software.
		  Ans. �The process of making digital recordings (audio or video) that are available for 

downloading is called podcasting. iPodder and iTunes are examples of podcast software.


